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Jump to State-Specific Notes

Release notes provide the applicable personnel the ability to review enhancements, modifications,
and regulated changes prior to accepting an updated. It is advised that users review the release
notes carefully and alert appropriate district staff to changes in Campus. 

The Release Information (https://kb.infinitecampus.com/help/release-
information) article lists the approximate release date of all Campus
releases. 

See the Rx Pack - Campus.2207 (https://infinite-campus-oct-
22.knowledgeowl.com/help/rx-pack-campus2207) article for a list of Rx
releases to the Campus.2207 release pack.

Questions or concerns regarding an update should be directed to
Campus Support.

Campus.2211
> Campus.2207
Campus.2203 (https://infinite-
campus-oct-
22.knowledgeowl.com/help/release-
pack-campus2203-january-2022)
Campus.2152 (https://infinite-
campus-oct-
22.knowledgeowl.com/help/release-
pack-campus2152-december-2021)
Campus.2148 (https://infinite-
campus-oct-
22.knowledgeowl.com/help/release-
pack-campus2148-november-2021)

See the Supported Platforms (https://kb.infinitecampus.com/help/supported-platforms) article for more
information about supported technologies. 

Update Manifest
See the Campus Release Pack Enhancements (https://kb.infinitecampus.com/help/campus-release-pack-
enhancements) article for a list of just enhancement release notes. 

Core Cases
Component Case Number Description

Activity
Registration

SIS-151606 Update for Copying Activities

Activity
Registration

SIS-152986 Activity Registration Maintenance

Activity
Registration

SIS-152987 Update for Activity Proposals

Activity
Registration

SIS-153248 [Enhancement] Excel File for Activity Roster Updated
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Ad hoc Reporting SIS-146843 SAML and Force Password Change Causing Pivot
Designer to Give 404 Error

Ad hoc Reporting SIS-151422 [Enhancement] Ad Hoc– Him/Her and His/Hers
Pronouns Added to Campus Fields

Ad hoc Reporting SIS-152332 Ad Hoc Cube Analysis Producing Differing Results
Between Web Browsers

Ad hoc Reporting SIS-152890 Ad Hoc Pivot Designer Teacher Dimension Displaying
Incorrect Teacher Names

Attendance SIS-131421 Length of Time to Preview Attendance Letters

Attendance SIS-150498 Letter Wizard- Removing Added Space from Translated
Languages Templates

Campus Instruction SIS-115936 Grade Book - Section Groups Tool Rights

Campus Instruction SIS-135272 [Enhancement] Grade Book - Student Name Suffix

Campus Instruction SIS-152647 Missing Assignment Preferences

Campus Instruction SIS-152842 Editing an Assignment

Campus Learning SIS-150888 [Enhancement] Instruction - Discussions

Campus Learning SIS-151723 [Enhancement] Curriculum List Improvements

Campus Learning SIS-152950 Assignment with a File and a Quiz

Campus
Student/Parent

SIS-153175 Campus Student & Parent Updates

Combine Person SIS-153145 Combine Person Fix

Custom SIS-134772 Custom Outline Links URL Updated to Max Size of
Varchar 2000

Custom SIS-152391 Custom Tool Placement Editor No Longer Focuses on
Sort Name

Custom SIS-152563 Buttons Updated on Custom Tool Placement Editor

Data Validation SIS-152876 Data Validation Rules and Groups Cancel Button
Update

Early Warning SIS-152207 Early Warning Updated to Query State Grade Level
Definition Values

Early Warning SIS-152313 Early Warning Failing to Remember School and Grade
Level Selection

eTranscript SIS-152234 [Enhancement] eTranscripts - XML Graduation Seal
Updates

http://infinite-campus-oct-22.knowledgeowl.com/#saml-and-force-password-change-causing-pivot-designer-to-give-404-error%C2%A0sis-146843
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http://infinite-campus-oct-22.knowledgeowl.com/#grade-book---section-groups-tool-rights-sis-115936
http://infinite-campus-oct-22.knowledgeowl.com/#grade-book---student-name-suffix-sis-135272-%5Benhancement%5D%C2%A0
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http://infinite-campus-oct-22.knowledgeowl.com/#custom-tool-placement-editor-no-longer-focuses-on-sort-name-sis-152391
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Events and Actions SIS-151490 [Enhancement] Access to Non DBO Tables Added

Federal Programs SIS-152385 CRDC – Maintain Survey Results Update

Learner Planning SIS-149622 PLP Caseload Update

Navigation SIS-151627 [Enhancement] Alias (Nickname) Now Shows in Title
Bar in New Look of Infinite Campus

Navigation SIS-152369 [Enhancement] Inactive Status Added to Course
Names in New Look of Infinite Campus

Navigation SIS-152371 [Enhancement] Disabled Status Added to Usernames
in New Look of Infinite Campus

Navigation SIS-152432 [Enhancement] Users No Longer Prompted for
Feedback Each Time They Toggle Off the New Look of
Infinite Campus

OneRoster SIS-151691 OneRoster 1.2 - Excluded Grading Tasks

OneRoster SIS-151741 OneRoster - Incorrect Process Alerts

Online Payments SIS-152466 [Enhancement] Support for Vanco Platform has Ended

Point of Sale SIS-147508 Cosmetic Update to Printed Reports

Scheduling SIS-151687 Teacher Schedule Batch - Terms Selection

School Store SIS-153063 Tool Rights Update for Settings Tool

Security SIS-151525 Calendar Rights Performance Update

Security SIS-152176 Security Update

Security SIS-152763 Users with PIV Authentication No Longer Asked to
Change Password or Do Two Step Authentication

Security SIS-152791 Compromised Password Ad Hoc Field Added to Ad Hoc
Reporting

Security SIS-152894 Database Connection Handling on Login Page Causing
Connection Pool Issues

Transcripts SIS-151676 Transcripts - School Year Sort Error

State-Specific Cases
State Case

Number
Description

All SIS-149782 [Enhancement] Banner Announcing Deprecation Added to
Campus Attribute Comparison Report

http://infinite-campus-oct-22.knowledgeowl.com/#access-to-non-dbo-tables-added-sis-151490-%5Benhancement%5D%C2%A0
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All SIS-150307 [Enhancement] Data Certification – New Certification
Category Tool

Arizona SIS-129709 State Immunization Report Updates

Arizona SIS-151088 Special Ed Updates

Arizona SIS-151608 Ed-Fi No Gifted Program Checkbox Updates

Arizona SIS-151790 Ed-Fi Educator Stakeholder ID and Staffs Resource Updates

Arizona SIS-152175 Tribal Affiliation

Arizona SIS-152744 Student Attendance Extract to Exclude Inactive Trials

Arizona SIS-152755 Ed-Fi Resource Updates for SPED Funding School

Arizona SIS-152872 Special Ed IEP Fix

Arizona SIS-153077 Luganda Language Added

BIE SIS-129490 New ERC Field (School History) and BIE Version Added to
Enrollment Summary Report

BIE SIS-150477 CONTROLLED Header Removed From BIE Reports Not
Containing PII

BIE SIS-150530 Update for BIE Reports with PII

BIE SIS-152925 Time-Based Two-Factor Authentication Enabled for All User
Accounts

California SIS-150351 CALPADS Student Information Address Logic

California SIS-151135 Monthly Attendance Summary

California SIS-152101 CALPADS Student Information Preferred First/Last Name
Values

Colorado SIS-151294 Evaluation Fix

Colorado SIS-152765 Graduation Guidelines

Hawaii SIS-150607 Special Ed Plan Added

Hawaii SIS-152387 Comparable Service Plan Added

Idaho SIS-152959 State Programs in Navigation

Illinois SIS-151902 Gender Reporting

Illinois SIS-152496 Student Course Assignment Extract - Course End Date

Illinois SIS-152620 IEIN Value on Birth to 3 Program Editor

Illinois SIS-153176 ISBE Extracts and Strip Apostrophes

http://infinite-campus-oct-22.knowledgeowl.com/#data-certification-%E2%80%93-new-certification-category-tool-sis-150307-%5Benhancement%5D%C2%A0
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http://infinite-campus-oct-22.knowledgeowl.com/#bie-%E2%80%93-time-based-two-factor-authentication-enabled-for-all-user-accounts-sis-152925
http://infinite-campus-oct-22.knowledgeowl.com/#california---calpads-student-information-address-logic-sis-150351
http://infinite-campus-oct-22.knowledgeowl.com/#california---monthly-attendance-summary-sis-151135
http://infinite-campus-oct-22.knowledgeowl.com/#california---calpads-student-information-preferred-first/last-name-values-sis-152101
http://infinite-campus-oct-22.knowledgeowl.com/#colorado-evaluation-fix-sis-151294
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http://infinite-campus-oct-22.knowledgeowl.com/#hawaii-special-ed-plan-added-sis-150607
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http://infinite-campus-oct-22.knowledgeowl.com/#idaho---state-programs-in-navigation-sis-152959
http://infinite-campus-oct-22.knowledgeowl.com/#illinois---gender-reporting-sis-151902
http://infinite-campus-oct-22.knowledgeowl.com/#illinois---student-course-assignment-extract---course-end-date-sis-152496
http://infinite-campus-oct-22.knowledgeowl.com/#illinois---iein-value-on-birth-to-3-program-editor-sis-152620
http://infinite-campus-oct-22.knowledgeowl.com/#illinois---isbe-extracts-and-strip-apostrophes-sis-153176
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Indiana SIS-151287 Ed-Fi Staff Section Associations Resource

Indiana SIS-151289 Ed-Fi Student Title 1 Part A Program Associations Resource

Kentucky SIS-151714 [Enhancement] Custom Gifted Form Batch Print Tool
Updated to Print Interactive with Database Table Forms

Kentucky SIS-152981 Birth Country Dictionary Update

Kentucky SIS-153097 Validation Added to Pre-School Tab

Maine SIS-152472 Validation Requiring Date Entered US for an Immigrant Value
Removed

Maine SIS-152554 Covid Diploma Graduation Year End Status Attribute Added

Maryland SIS-152650 New National Code Value Added to Test Setup (Assessments)

Maryland SIS-152652 New Values Added to Subject List in Test Setup (Assessments)

Maryland SIS-152851 KRA/ELA Extract Updated

Maryland SIS-152934 SCED Course Identifier Code Updates

Massachusetts SIS-152610 IEP FIX

Massachusetts SIS-152811 SIF EmploymentRecord Logic Correction

Massachusetts SIS-152812 Various SIF Updates

Massachusetts SIS-153138 SIF StaffAssignment Updated to Report Sections with Non-
State Excluded Secondary Enrollments

Massachusetts SIS-153212 Behavior State Event and Weapon Type Updates

Michigan SIS-152343 State Graduation Seals

Michigan SIS-152546 Ed-Fi Student School Associations Update

Minnesota SIS-143241 MCCC Staff Course Record Update

Minnesota SIS-151556 IEP Print Fix

Minnesota SIS-152712 Ed-Fi Student Education Organization Associations Update

Missouri SIS-151618 MOSIS Student Core Update

Missouri SIS-152044 IEP Updates

Montana SIS-152871 Student Locator Age Validation Calculation Update

Nebraska SIS-149032 [Enhancement] P-EBT Extract

Nebraska SIS-152691 Home Primary Language Update

Nevada SIS-151866 NV Nutrition Report- NSLP Reporting Logic Updated

Nevada SIS-152050 New Behavior Event Code Mapping Option Added

http://infinite-campus-oct-22.knowledgeowl.com/#indiana---ed-fi-staff-section-associations-resource-sis-151287
http://infinite-campus-oct-22.knowledgeowl.com/#indiana---ed-fi-student-title-1-part-a-program-associations-resource-sis-151289
http://infinite-campus-oct-22.knowledgeowl.com/#kentucky-%E2%80%93-custom-gifted-form-batch-print-tool-updated-to-print-interactive-with-database-table-forms-sis-151714-%5Benhancement%5D%C2%A0
http://infinite-campus-oct-22.knowledgeowl.com/#kentucky-%E2%80%93-birth-country-dictionary-update-sis-152981
http://infinite-campus-oct-22.knowledgeowl.com/#kentucky-%E2%80%93-validation-added-to-pre-school-tab-sis-153097
http://infinite-campus-oct-22.knowledgeowl.com/#maine-%E2%80%93-validation-requiring-date-entered-us-for-an-immigrant-value-removed-sis-152472
http://infinite-campus-oct-22.knowledgeowl.com/#maine-%E2%80%93-covid-diploma-graduation-year-end-status-attribute-added-sis-152554
http://infinite-campus-oct-22.knowledgeowl.com/#maryland%E2%80%93-new-national-code-value-added-to-test-setup-assessments-\(sis-152650\)
http://infinite-campus-oct-22.knowledgeowl.com/#maryland%E2%80%93-new-values-added-to-subject-list-in-test-setup-assessments-\(sis-152652\)
http://infinite-campus-oct-22.knowledgeowl.com/#maryland%E2%80%93-kra/ela-extract-updated-sis-152851
http://infinite-campus-oct-22.knowledgeowl.com/#maryland%E2%80%93-sced-course-identifier-code-updates-sis-152934
http://infinite-campus-oct-22.knowledgeowl.com/#massachusetts-iep-fix-sis-152610
http://infinite-campus-oct-22.knowledgeowl.com/#massachusetts-%E2%80%93-sif-employmentrecord-logic-correction-sis-152811
http://infinite-campus-oct-22.knowledgeowl.com/#massachusetts-%E2%80%93-various-sif-updates-sis-152812
http://infinite-campus-oct-22.knowledgeowl.com/#massachusetts-%E2%80%93-sif-staffassignment-updated-to-report-sections-with-non-state-excluded-secondary-enrollments-sis-153138
http://infinite-campus-oct-22.knowledgeowl.com/#massachusetts-%E2%80%93-behavior-state-event-and-weapon-type-updates-sis-153212
http://infinite-campus-oct-22.knowledgeowl.com/#michigan---state-graduation-seals-sis-152343
http://infinite-campus-oct-22.knowledgeowl.com/#michigan---ed-fi-student-school-associations-update-sis-152546
http://infinite-campus-oct-22.knowledgeowl.com/#minnesota---mccc-staff-course-record-update-sis-143241
http://infinite-campus-oct-22.knowledgeowl.com/#minnesota-iep-print-fix-sis-151556
http://infinite-campus-oct-22.knowledgeowl.com/#minnesota---ed-fi-student-education-organization-associations-update-sis-152712
http://infinite-campus-oct-22.knowledgeowl.com/#missouri-mosis-student-core-update-sis-151618
http://infinite-campus-oct-22.knowledgeowl.com/#missouri-iep-updates-sis-152044
http://infinite-campus-oct-22.knowledgeowl.com/#montana-%E2%80%93-student-locator-age-validation-calculation-update-sis-152871
http://infinite-campus-oct-22.knowledgeowl.com/#nebraska---p-ebt-extract-sis-149032-%5Benhancement%5D%C2%A0
http://infinite-campus-oct-22.knowledgeowl.com/#nebraska---home-primary-language-update-sis-152691
http://infinite-campus-oct-22.knowledgeowl.com/#nevada%E2%80%93-nv-nutrition-report--nslp-reporting-logic-updated-sis-151866
http://infinite-campus-oct-22.knowledgeowl.com/#nevada%E2%80%93-new-behavior-event-code-mapping-option-added-sis-152050


Copyright © 2021 Infinite Campus. All rights reserved.

Nevada SIS-152246 SCED Course Level in Attribute/Dictionary Updated

New Mexico SIS-152881 Student Summary Attendance Template Update

New York SIS-148983 SSEC Extract Update

New York SIS-152645 SIRS Student Digital Access Fix

New York SIS-152695 State Program Codes Added

New York SIS-152727 SIRS Student Lite Update

New York SIS-152764 SIRS Student Daily Attendance Update

Ohio SIS-148718 Local Student Number

Ohio SIS-150272 Student Assessment (FA) Extract Update

Ohio SIS-150451 CORE Area for Credit Field

Ohio SIS-151841 Immunizations Update

Ohio SIS-152982 Student Standing (FS) Performance

Oklahoma SIS-152320 Course State Exclude Checkbox

Oklahoma SIS-152694 [Enhancement] Statistical Summary Report, Transportation
Report

Oklahoma SIS-152705 Native American Eligibility and Custom Attributes

Oklahoma SIS-152722 [Enhancement] Attendance Summary

Pennsylvania SIS-139833 Immunizations Update

Pennsylvania SIS-152593 PIMS Programs Fact Template Logic Update

Tennessee SIS-137563 Immunizations Update

Tennessee SIS-151745 22-23 Version

Texas SIS-152800 Logic Updated to Student Parent Interchange for ECDS KG
Submission

Texas SIS-153060 Assessment Logic Updated in the TREx Extract

Wisconsin SIS-151707 Special Ed Updates

Wisconsin SIS-151907 WISE Attendance Audit Update

Wisconsin SIS-152473 Ed-Fi Student CTE Program Association Error

Wyoming SIS-149582 SIF Attendance Calculation Field Added to Calendar and
Related SIF Updates

Wyoming SIS-151622 IEP Update

Wyoming SIS-152311 WDE-638 Course File

http://infinite-campus-oct-22.knowledgeowl.com/#nevada%E2%80%93-sced-course-level-in-attribute/dictionary-updated-sis-152246
http://infinite-campus-oct-22.knowledgeowl.com/#new-mexico%E2%80%93-student-summary-attendance-template-updatesis-152881
http://infinite-campus-oct-22.knowledgeowl.com/#new-york-ssec-extract-update-sis-148983
http://infinite-campus-oct-22.knowledgeowl.com/#new-york-sirs-student-digital-access-fix-sis-152645
http://infinite-campus-oct-22.knowledgeowl.com/#new-york-state-program-codes-added-sis-152695
http://infinite-campus-oct-22.knowledgeowl.com/#new-york-sirs-student-lite-update-sis-152727
http://infinite-campus-oct-22.knowledgeowl.com/#new-york-sirs-student-daily-attendance-update-sis-152764
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Wyoming SIS-152334 SIF StudentParticipation Logic Update

Technical Information
See the Technical Information - Release Pack Campus.2207 (https://infinite-campus-oct-
22.knowledgeowl.com/help/technical-information-release-pack-campus2207) article for a list of schema changes in
this release.

Activity Registration
Update for Copying Activities (SIS-151606)

The image and price were missing from the last step in the Activity builder when an activity was
copied. This issue was corrected.

Article(s): Activity Dashboard (https://infinite-campus-oct-22.knowledgeowl.com/help/activity-dashboard)

Path: Activity Registration > Activity Dashboard

Activity Registration Maintenance (SIS-152986)

The following improvements were made to Activity Registration.

Schools now display in alphabetical order on the Create Activity (first screen) and the Link to
Portal (fourth screen) of the Activity Builder.
A warning message was added to the Activity Roster that warns users when they are about to
leave the forms screen with unsaved changes.
Emancipated students could not sign forms when opening the form from Activity Registration.
This issue was corrected.
When students are manually added to an Activity Roster, the students grade level now
displays immediately on the roster.

Article(s): Activity Registration (https://infinite-campus-oct-22.knowledgeowl.com/help/activity-registration-overview)

Path: Activity Registration

Update for Activity Proposals (SIS-152987)

A text box called "Description" now displays for all users on the Build Roster screen in the Activity
Proposal progress tracker. The Description text box allows you to enter a description of the eligible
participants. Previously, the text box only displayed if you did not have tool rights to Ad Hoc.

Article(s): Activity Dashboard (https://infinite-campus-oct-22.knowledgeowl.com/help/activity-dashboard)

Path: Activity Registration > Activity Dashboard
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Excel File for Activity Roster Updated (SIS-153248) [Enhancement] 

The Excel file that users can export from the Activity Roster tool now includes a column for each
required and/or optional form. Forms are marked as TRUE when they are complete and FALSE
when they are incomplete. Required forms include an asterisk ( * ) in front of the form name.

Article(s): Activity Monitor and Activity Roster (https://infinite-campus-oct-22.knowledgeowl.com/help/activity-
monitor-and-activity-roster-2631)

Path: Activity Registration > Activity Monitor

Ad hoc Reporting
SAML and Force Password Change Causing Pivot Designer to Give 404 Error (SIS-146843)

Pivot Designer was generating a 404 error for users who have an Authentication Type set to SAML
Authentication and have the Force Password Change field marked on their User Account. This issue
was corrected.

Article(s): Pivot Designer (https://infinite-campus-oct-22.knowledgeowl.com/help/pivot-designer)

Path: Ad Hoc Reporting > Data Analysis > Pivot Designer

Ad Hoc– Him/Her and His/Hers Pronouns Added to Campus Fields (SIS-151422) [Enhancement] 

Him/Her and His/Hers pronouns have been added as Campus Field options in Ad hoc Reporting and
WYSIWYG editors. The fields are located under Student > Demographics.

Article(s): Student Filter Fields for Ad hoc Reporting (https://infinite-campus-oct-
22.knowledgeowl.com/help/student-filter-fields-for-ad-hoc-reporting)

Path: Ad Hoc Reporting > Filter Designer or Data Viewer > Student > Demographics

Ad Hoc Cube Analysis Producing Differing Results Between Web Browsers (SIS-152332)

Cube Analysis functionality was behaving and producing differing results depending on which web
browser the user was working within. This issue was corrected.

Article(s): Data Export (https://infinite-campus-oct-22.knowledgeowl.com/help/data-export)

Path: Ad Hoc Reporting > Data Export > Export Format > Cube Analysis

Ad Hoc Pivot Designer Teacher Dimension Displaying Incorrect Teacher Names (SIS-152890)

http://infinite-campus-oct-22.knowledgeowl.com/help/activity-monitor-and-activity-roster-2631
https://infinite-campus-oct-22.knowledgeowl.com/help/activity-monitor-and-activity-roster-2631
http://infinite-campus-oct-22.knowledgeowl.com/help/pivot-designer
https://infinite-campus-oct-22.knowledgeowl.com/help/pivot-designer
http://infinite-campus-oct-22.knowledgeowl.com/help/student-filter-fields-for-ad-hoc-reporting
https://infinite-campus-oct-22.knowledgeowl.com/help/student-filter-fields-for-ad-hoc-reporting
http://infinite-campus-oct-22.knowledgeowl.com/help/data-export
https://infinite-campus-oct-22.knowledgeowl.com/help/data-export


Copyright © 2021 Infinite Campus. All rights reserved.

A bug was causing the Teacher dimension in the Pivot Designer tool to display incorrect teacher
names. This issue was corrected.

Article(s): Pivot Designer (https://infinite-campus-oct-22.knowledgeowl.com/help/pivot-designer)

Path: Ad Hoc Reporting > Data Analysis > Pivot Designer

Attendance
Length of Time to Preview Attendance Letters (SIS-131421)

The query used to preview/generate Attendance Letters has been optimized for performance and a
shorter generation time.

Article(s): Attendance Letters (https://infinite-campus-oct-22.knowledgeowl.com/help/attendance-letters)

Path: Attendance Letters

Attendance - Letter Wizard - Removing Added Space from Translated Languages Templates (SIS-
150498)

When the translated languages template was used in any of the Campus Letter Wizards, extra
space was added to the bottom of the letter upon selecting Save Format(s). This has been fixed.

Article(s): Attendance Letters (https://infinite-campus-oct-22.knowledgeowl.com/help/attendance-letters)

Path: Attendance > Attendance Letters

Campus Instruction
Grade Book - Section Groups Tool Rights (SIS-115936)

Previously, users received an error in the Grade Book if attempting to use Section Groups when the
user did not have tool rights to Student Groups. This has been corrected.

Article(s): Section Groups (https://infinite-campus-oct-22.knowledgeowl.com/help/section-groups-campus-instruction)

Path: Instruction > Grade Book > Settings > Section Groups

Grade Book - Student Name Suffix (SIS-135272) [Enhancement] 

The Grade Book has been updated to display a student's name suffix if they have one.

Article(s): Grade Book (https://infinite-campus-oct-22.knowledgeowl.com/help/grade-book-articles)

Path: Instruction > Grade Book
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Missing Assignment Preferences (SIS-152647)

Previously, when a user made changes to the Missing Assignment Preferences, the Auto-Calculate
checkbox would be unmarked in Calendars that the user did not have calendar rights to. This has
been corrected.

Article(s): Missing Assignment Preferences (https://infinite-campus-oct-22.knowledgeowl.com/help/missing-
assignment-preferences)

Path: System Administration > Grading & Standards > Missing Assignments

Editing an Assignment (SIS-152842)

When a user edits an assignment that is aligned to multiple sections, a message should display
upon Save allowing the user to apply the change to other instances of the assignment or not.
Previously, this message was not displaying for some users. This has been corrected.

Article(s): Assignments & Resources (https://infinite-campus-oct-22.knowledgeowl.com/help/assignments-resources)

Path: Instruction > Grade Book > select assignment > Edit

Campus Learning
Instruction - Discussions (SIS-150888) [Enhancement] 

Discussions have been updated so that discussions can only be created in the context of
assignments, for scored discussions, or resources, for discussions that are not scored. Teachers
can still use the Discussions tool to manage existing discussions, including viewing student posts,
responding, and addressing flagged posts.

Article(s): Discussions (https://infinite-campus-oct-22.knowledgeowl.com/help/discussions-instruction), Discussions
Administration (https://infinite-campus-oct-22.knowledgeowl.com/help/discussions-system-administration)

Path: Instruction > Grade Book > Add > Discussion

Curriculum List Improvements (SIS-151723) [Enhancement] 

The following improvements have been made to the Curriculum List:

Three numbers have been added to the far right of each scored item, which indicate the
number of assignments that have been turned in via Campus Student but not yet scored, the
number of students who received the assignment, and the number of assignments scored.
Click the Turned In number to view the submission, the Assigned number to individualize the
assignment, or the Scored number to score the assignment.
Tabs have been added across the top of the list, which allow the teacher to view just
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Assignments, Discussions, Quizzes, and assignments with Submissions.
The List can now be filtered by Term and assignments in the list can be filtered by All, any
Unscored assignments, and any assignments that include a student flagged as Missing.

Articles(s): Curriculum List (https://infinite-campus-oct-22.knowledgeowl.com/help/curriculum-list)

Path: Various areas of Instruction, including Grade Book > List

Assignment with a File and a Quiz (SIS-152950)

Previously, if an assignment had both a quiz and another piece of content linked to it (such as a
file), the assignment could not be modified and saved. This has been corrected.

Article(s): Assignments & Resources (https://infinite-campus-oct-22.knowledgeowl.com/help/assignments-resources)

Path: Instruction > Grade Book > Add > Assignment

Campus Student/Campus Parent
Campus Student & Parent Updates (SIS-153175)

The following updates have been made to Campus Student and/or Campus Parent:

Previously, the student number barcode did not display in Campus Student if the POS Barcode
was not enabled. This has been corrected.
Campus Parent has been updated to restore the sort order of students in the student selector.
Students are sorted by Last Name, First Name, Middle Initial.
Previously, when a user clicked on a push notification for food service or a document
requiring an eSignature, the app did not open to the correct tool. This has been corrected.

Article(s): Campus Student (https://infinite-campus-oct-22.knowledgeowl.com/help/campus-student-portal), Campus
Parent (https://infinite-campus-oct-22.knowledgeowl.com/help/campus-parent-portal)

Path: Campus Student, Campus Parent

Combine Person
Combine Person Fix (SIS-153145)

The Payments Notification for Deposit Request Report (SIS-148981) introduced a change that
broke the Combine Person tool. This issue was fixed.

Article(s): N/A

Path: System Admin > Data utilities > Combine Person
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Custom
Custom Outline Links URL Updated to Max Size of Varchar 2000 (SIS-134772)

The URL field for Custom Outline Links had a limit of 800 characters, preventing users from
creating links for very long URLs such as Ad Hoc Pivot Tables. To correct this issue, the field has
been changed to a maximum length of Varchar 2000 (the longest some web browsers support).

Article(s): Outline Links (https://infinite-campus-oct-22.knowledgeowl.com/help/outline-links)

Path: System Administration > Custom > Outline Links

Custom Tool Placement Editor No Longer Focuses on Sort Name (SIS-152391)

When selecting the New Tool Mapping button in the Custom Tool Placement Editor, the tool was
focusing on the Sort Name (Optional) field instead of the first field on the form. This issue was
corrected.

Article(s): Custom Tool Placement Editor (https://infinite-campus-oct-22.knowledgeowl.com/help/custom-tool-
placement-editor)

Path: System Administration > Custom > Custom Tool Placement Editor

Buttons Updated on Custom Tool Placement Editor (SIS-152563)

The order of the buttons on the Custom Tool Placement Editor have been updated to the following:
New Tool Mapping, New Category, New Menu Item. Also, the New Tool Mapping button now
appears blue.

Article(s): Custom Tool Placement Editor (https://infinite-campus-oct-22.knowledgeowl.com/help/custom-tool-
placement-editor)

Path: System Administration > Custom > Custom Tool Placement Editor

Data Validation
Data Validation Rules and Groups Cancel Button Update (SIS-152876)

The Data Validation Rules and Data Validation Groups tools have been updated to display a
message when the Cancel button is selected and changes have not been saved.

Article(s): Data Validation Rules (https://infinite-campus-oct-22.knowledgeowl.com/help/validation-rules), Data
Validation Groups (https://infinite-campus-oct-22.knowledgeowl.com/help/validation-groups)

Path: Data Integrity > Data Validation > Validation Rules, Data Integrity > Data Validation >
Validation Groups
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Early Warning
Early Warning Updated to Query State Grade Level Definition Values (SIS-152207)

An issue was causing some districts to not receive Early Warning scores when Enrollment grade
levels differed from State-level grade values. To correct this issue, the prediction query has been
updated to include the StateLevelGradeDefinition value.

Article(s): Early Warning (https://infinite-campus-oct-22.knowledgeowl.com/help/early-warning)

Path: Student Information > Counseling > Early Warning

Early Warning Failing to Remember School and Grade Level Selection (SIS-152313)

The Early Warning tool was failing to remember the school and grade level options selected after
viewing a specific student’s data.

Article(s): Early Warning (https://infinite-campus-oct-22.knowledgeowl.com/help/early-warning)

Path: Student Information > Counseling > Early Warning

eTranscript
eTranscripts - XML Graduation Seal Updates (SIS-152234) [Enhancement] 

The eTranscripts XML layout now includes the Graduation Seal Method in the Academic Record >
Academic Award > Academic Honors as a Note Message.

When a Graduation Seal includes both a Language and a Method, two separate Note Messages
report.

For Kentucky users, when printing a student's Transcript, the Name of the Seal and the Name of
the Method print if the State Seals report preference is selected.

Article(s): PESC XML Output for eTranscripts (https://infinite-campus-oct-22.knowledgeowl.com/help/pesc-xml-output-
for-etranscripts)

Path: Grading and Standards > Reports > eTranscript Batch

Events and Actions
Access to Non DBO Tables Added (SIS-151490) [Enhancement] 

The Events and Actions tool was updated to give users access to schema for the Scanning tool,
Forms tool, and to custom tables. Previously, users could only access dbo tables.

Article(s): Events and Actions (https://infinite-campus-oct-22.knowledgeowl.com/help/events-and-actions)
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Path: System Administration > Events & Actions > Events & Actions Configuration

Federal Programs
CRDC – Maintain Survey Results Update (SIS-152385)

The Maintain Surveys Results tool was previously not displaying accurate values when results were
being generated for individual modules. The SCHR: School Characteristics module must be
generated at least once for a given school prior to independently generating results for other
modules. A validation has been put in place to ensure users generate the SCHR: School
Characteristics module results first.

Article(s): Maintain CRDC Survey Results (https://infinite-campus-oct-22.knowledgeowl.com/help/maintain-crdc-survey-
results)

Path: Federal Reporting > Civil Rights Data Collection (CRDC) > Maintain Survey Results

Learner Planning
PLP Caseload Update (SIS-149622)

A new column, Meeting Date, has been added to the PLP Caseload.

Article: PLP Caseload (https://infinite-campus-oct-22.knowledgeowl.com/help/caseload-plp)

Path: Student Information > PLP > Caseload

Navigation
Alias (Nickname) Now Shows in Title Bar in New Look of Infinite Campus (SIS-151627)
[Enhancement] 

A person’s alias (nickname) and middle initial now appear in the title bar for the person in the New
Look of Infinite Campus.

Note: The alias (nickname) will only display on larger screens and will disappear from view as the
screen shrinks below a certain size threshold. A person’s middle initial will continue to appear
regardless of screen size.

Article(s): Try the New Look of Campus (https://infinite-campus-oct-22.knowledgeowl.com/help/try-the-new-look-of-
campus)

Path: N/A

Inactive Status Added to Course Names in New Look of Infinite Campus (SIS-152369)
[Enhancement] 
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Inactive courses will now display (Inactive) after the course name in search results and the title bar
in the New Look of Infinite Campus.

Article(s): Try the New Look of Campus (https://infinite-campus-oct-22.knowledgeowl.com/help/try-the-new-look-of-
campus)

Path: N/A

Disabled Status Added to Usernames in New Look of Infinite Campus (SIS-152371)
[Enhancement] 

Disabled user accounts will now display (Disabled) after the user’s username in search results and
the title bar in the New Look of Infinite Campus.

Article(s): Try the New Look of Campus (https://infinite-campus-oct-22.knowledgeowl.com/help/try-the-new-look-of-
campus)

Path: N/A

Users No Longer Prompted for Feedback Each Time They Toggle Off the New Look of Infinite
Campus (SIS-152432) [Enhancement] 

Users are no longer prompted to submit feedback each time they toggle off the New Look of
Infinite Campus

Article(s): Try the New Look of Campus (https://infinite-campus-oct-22.knowledgeowl.com/help/try-the-new-look-of-
campus)

Path: N/A

OneRoster
OneRoster 1.2 - Excluded Grading Tasks (SIS-151691)

Previously, Grading Tasks marked as External LMS Exclude were still generating ScaleScore
records. This has been corrected.

Article(s): OneRoster API (https://infinite-campus-oct-22.knowledgeowl.com/help/oneroster-api-e6d9361)

Path: No Specific Path

OneRoster - Incorrect Process Alerts (SIS-151741)

When the Student and Class caches of OneRoster data were updated to automatically refresh
when specific changes are made, users received the same Process Alert as was generated when
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they clicked 'Refresh OneRoster Cache'. This has been corrected.

Article(s): OneRoster API (https://infinite-campus-oct-22.knowledgeowl.com/help/oneroster-api-e6d9361)

Path: Message Center

Online Payments
Support for Vanco Platform has Ended (SIS-152466) [Enhancement] 

Support for the Vanco Platform has ended. Please complete the onboarding with Payrix and
migrate over to not have an interruption in service.

Article(s): N/A

Path: N/A

Point of Sale
Cosmetic Update to Printed Reports (SIS-147508)

The Total Debits and Total Credits were changed to be on separate lines on the printed Food
Service Account Journal and the Journal Batch report. This change makes it easier to see larger
balances.

Article(s): Journal (POS Account) (https://infinite-campus-oct-22.knowledgeowl.com/help/journal-pos-account); Journal
Batch (https://infinite-campus-oct-22.knowledgeowl.com/help/journal-batch)

Path: Point of Sale > Account Maintenance > Account > Journal; Point of Sale > Reports > Journal
Batch

Scheduling
Teacher Schedule Batch - Terms Selection (SIS-151687)

The Teacher Schedule Batch was not returning information for the selected terms when using the
Table Layout. This has been corrected.

Article(s): Teacher Schedule Batch (https://infinite-campus-oct-22.knowledgeowl.com/help/teacher-schedule-batch)

Path: Scheduling > Reports > Teacher Schedule Batch

School Store
Tool Rights Update for Settings Tool (SIS-153063)

Users with only R (Read) Tool Rights to Settings were able to make and save modifications on the
School Store > Administration > Settings screen. This issue was corrected.

http://infinite-campus-oct-22.knowledgeowl.com/help/oneroster-api-e6d9361
https://infinite-campus-oct-22.knowledgeowl.com/help/oneroster-api-e6d9361
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http://infinite-campus-oct-22.knowledgeowl.com/help/journal-batch
https://infinite-campus-oct-22.knowledgeowl.com/help/journal-batch
http://infinite-campus-oct-22.knowledgeowl.com/help/teacher-schedule-batch
https://infinite-campus-oct-22.knowledgeowl.com/help/teacher-schedule-batch


Copyright © 2021 Infinite Campus. All rights reserved.

Article(s): Settings (https://infinite-campus-oct-22.knowledgeowl.com/help/settings)

Path: School Store > Administration > Settings

Security
Calendar Rights Performance Update (SIS-151525)

Updates were made to ensure certain Calendar Rights scenarios no longer impact system
performance.

Article(s): N/A

Path: N/A

Security Update (SIS-152176)

Updates were made to reinforce system security.

Article(s): N/A

Path: N/A

Users with PIV Authentication No Longer Asked to Change Password or Do Two Step Authentication
(SIS-152763)

Users using PIV authentication were incorrectly being asked to change their password and/or log in
using two factor authentication if these values were enabled on their user account. Because PIV
authentication supersedes these authentication methods, an update was made to no longer notify
or require PIV users perform these actions, regardless of whether or not they are enabled on their
account.

Article(s): PIV Card Registration Process for Staff Members (https://infinite-campus-oct-
22.knowledgeowl.com/help/piv-card-registration-process-for-staff-members); PIV Card Registration Process for
Administrators (https://infinite-campus-oct-22.knowledgeowl.com/help/piv-card-registration-process-administrators)

Path: N/A

Compromised Password Ad Hoc Field Added to Ad Hoc Reporting (SIS-152791)

The Ad hoc field ‘accountManagement.pwnedPassword’ has been added to Ad Hoc Reporting tools.
If the ‘Prohibit Passwords That Have Been Previously Disclosed in a Data Breach’ Account Security
Preference is enabled, Infinite Campus accesses and utilizes a global database used to track
passwords and accounts affected by data breaches of non-Infinite Campus systems and identifies
any passwords within your system that matches passwords on this database. All passwords

http://infinite-campus-oct-22.knowledgeowl.com/help/settings
https://infinite-campus-oct-22.knowledgeowl.com/help/settings
http://infinite-campus-oct-22.knowledgeowl.com/help/piv-card-registration-process-for-staff-members
https://infinite-campus-oct-22.knowledgeowl.com/help/piv-card-registration-process-for-staff-members
http://infinite-campus-oct-22.knowledgeowl.com/help/piv-card-registration-process-administrators
https://infinite-campus-oct-22.knowledgeowl.com/help/piv-card-registration-process-administrators
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flagged as compromised can be pulled into Ad hoc filters and reports using this new
‘pwnedPassword’ field.

You can access this field via Campus Usage > Account Management > pwnedPassword.

Account Security Preferences are set via System Administration > User Security > User Preference
Management > Account Security Preferences

Article(s): Query Wizard (https://infinite-campus-oct-22.knowledgeowl.com/help/query-wizard), Account Security
Preferences (https://infinite-campus-oct-22.knowledgeowl.com/help/account-security-preferences-category)

Path: System Administration > User Security > User Preference Management > Account Security
Preferences; Ad Hoc Reporting > Filter Designer

Database Connection Handling on Login Page Causing Connection Pool Issues (SIS-152894)

An issue with database connection handling on login.jsp was corrected to prevent potential system
outages.

Article(s): N/A

Path: N/A

Transcripts
Transcripts - School Year Sort Error (SIS-151676)

A Failure to Load error was returned when a Transcript Report sorted by the School Year was
generated in PDF format. This has been corrected.

Within the By Term/Grade/Year format, Transcript records with the same School Number and
School Name print together, based on the School Number/Name values entered on the Transcript
Course Record. If there is no value for those fields, Number/Name information does not print for
that group of Transcript Records.

Article(s): Transcripts (https://infinite-campus-oct-22.knowledgeowl.com/help/transcripts); Transcript Batch
(https://infinite-campus-oct-22.knowledgeowl.com/help/transcript-batch)

Path: Student Information > General > Transcripts; Grading and Standards > Reports > Transcript
Batch

State-Specific Notes
Banner Announcing Deprecation Added to Campus Attribute Comparison Report (SIS-149782)
[Enhancement] 

A banner was added to the top of the Campus Attribute Comparison Report, announcing its
deprecation as of the Campus.2223 Release (June 2022).

http://infinite-campus-oct-22.knowledgeowl.com/help/query-wizard
https://infinite-campus-oct-22.knowledgeowl.com/help/query-wizard
http://infinite-campus-oct-22.knowledgeowl.com/help/account-security-preferences-category
https://infinite-campus-oct-22.knowledgeowl.com/help/account-security-preferences-category
http://infinite-campus-oct-22.knowledgeowl.com/help/transcripts
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Article(s): Campus Attribute Comparison Report (https://infinite-campus-oct-22.knowledgeowl.com/help/campus-
attribute-comparison-report)

Path: System Administration > Custom > Reports > Campus Attribute Comparison Report

Data Certification – New Certification Category Tool (SIS-150307) [Enhancement] 

A new Data Certification Category tool has been made available. This tool consolidates the
functionality of the existing Type and Type Membership tools; the existing tools will remain
available until the Data Certification redesign is complete.

Article(s): Certification Category (District Level) (https://infinite-campus-oct-22.knowledgeowl.com/help/certification-
category-certification-category), Certification Category (State Edition) (https://infinite-campus-oct-
22.knowledgeowl.com/help/certification-category-state-edition)

Path: Data Integrity Tools > Data Certification > Certification Category

Arizona
Arizona State Immunization Report Updates (SIS-129709)

The Arizona-specific Immunization report at Student Information > Health > General >
Immunizations has been updated to the current ASIR 109R version. In addition, the state-specific
Report Type in the Immunization Batch Report has been removed and the ASIR 109R report has
been added to Health > Reports as the School Immunization Report.

Article: N/A

Path: Student Information > Health > General > Immunizations

Arizona Special Ed Updates (SIS-151088)

Several updates have been made to the Arizona IEP, including:

Exit IEP has been added as an option has been added to the Reason for Meeting dropdown.
the Exit Reason dropdown field has been added to the Education Plan editor. A Comments has
also been added.
a new editor, Meeting Notes, has been added.
a new field, SPED Funding School, has been added to the Enrollment Status editor.

The Parental Prior Written Notice Custom Form has also been added.

Article: Individual Education Plan (Arizona) (https://infinite-campus-oct-22.knowledgeowl.com/help/individual-
education-plan-arizona)

Path: Student Information > Special Ed > General > Documents

http://infinite-campus-oct-22.knowledgeowl.com/help/campus-attribute-comparison-report
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Arizona - Ed-Fi No Gifted Program Checkbox Updates (SIS-151608)

The No Gifted Program checkbox has been added to the Gifted tool to indicate students that have
tested as 'Gifted', but are not being serviced.

The Student Program Associations resource has been updated to not send a record if the No Gifted
Program checkbox is marked. The trigger logic has also been updated to delete the Student
Program Associations record if the No Gifted Program checkbox is selected.

‘NOND: No Need’ has been added to the list of values in the Gifted Need dropdown in the Gifted
tool.

Districts need to map the new ‘NOND: No Need’ value to the Ed-Fi NOND value in the Student
Needs Resource Preferences for the Gifted Needs descriptors.

Article(s): Arizona Ed-Fi Data v3.5 - Student Program Associations (https://infinite-campus-oct-
22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-program-associations), Ed-Fi v3.X - Student Needs Resource
Preferences (https://infinite-campus-oct-22.knowledgeowl.com/help/ed-fi-v31---student-needs-resource-preferences)

Path: Student information > Program Participation > Gifted, System Administration > Ed-Fi

Arizona - Ed-Fi Educator Stakeholder ID and Staffs Resource Updates (SIS-151790)

The Educator Stakeholder Id has been moved from the Staff State Id to the License Number field
on the District Employment tool.

The size of the License Number field on the District Employment tool has been increased to 16
characters.

The staffIdentificationSystemDescriptor and identificationCode elements in the Staffs resource
have been updated to report from the License Number field.

The triggering logic in the Staffs resource has been updated to perform a ‘Put’ when the
Employment Start Date/End Date or License Number field is changed.

A conversion script has been created to move the Educator Stakeholder Id from the Staff State Id
field to the License Number field.

A conversion script has been created to copy the student Ed-Fi Id from the Ed-Fi Id field to the
Student State Id field.

Article(s): Arizona Ed-Fi Data v3.5 - Staffs (https://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-
v35-staff)

Path: System Administration > Ed-Fi

http://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-program-associations
https://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-program-associations
http://infinite-campus-oct-22.knowledgeowl.com/help/ed-fi-v31---student-needs-resource-preferences
https://infinite-campus-oct-22.knowledgeowl.com/help/ed-fi-v31---student-needs-resource-preferences
http://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-staff
https://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-staff


Copyright © 2021 Infinite Campus. All rights reserved.

Arizona – Tribal Affiliation (SIS-152175)

Tribal Affiliation code TA146 has been deactivated as it’s a duplicate of TA145. A conversion script
has been run to update any existing Tribal Affiliations from TA146 to TA145. Also, the Race
Category in Ad Hoc has been updated to show code TA145 and no longer report TA146.

Article(s): Census (Arizona) (https://infinite-campus-oct-22.knowledgeowl.com/help/census-arizona)

Path: Census > People > Identities > Tribal Affiliation

Arizona – Student Attendance Extract to Exclude Inactive Trials (SIS-152744)

Calculations for the Student Attendance Extract have been updated to exclude inactive trials.

Article(s): Attendance Extract (Arizona) (https://infinite-campus-oct-22.knowledgeowl.com/help/attendance-extract-
arizona)

Path: AZ State Reporting > Attendance Extract

Arizona - Ed-Fi Resource Updates for SPED Funding School (SIS-152755)

The following updates have been made in the Student Education Organization Responsibility
Associations, Student Needs (SPED Only), and Student Special Education Program Associations
resources:

The endDate triggering logic for students with multiple enrollments in different schools has
been updated to only calculate the end date based on the enrollment in the SPED Funding
School if the SPED Funding School field is populated on a student’s IEP.
The EducationOrganizationReference element has been updated to report the School Entity Id
field from the SPED Funded School if the SPED Funded School dropdown is populated.
The beginDate element has been updated to use the enrollment Start Date from the
enrollment tied to the SPED Funded School if the SPED Funded School dropdown is populated.
The endDate element has been updated to use the enrollment End Date from the enrollment
tied to the SPED Funded School if the SPED Funded School dropdown is populated.

The following update has only been made in the Student Special Education Program Associations
resource:

The MainSPEDSchool field has been updated to report ‘False’ if the SPED Concurrency Type is
‘Secondary’. Otherwise reports as 'True'.

A resync on the Student Education Organization Responsibility Associations, Student Needs, and
Student Special Education Program Associations resources needs to be completed with this
update.

Article(s): Arizona Ed-Fi Data v3.5 - Student Education Organization Responsibility Associations
(https://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-education-organization-responsibility-
associations), Arizona Ed-Fi Data v3.5 – Student Needs (https://infinite-campus-oct-
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22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-needs), Arizona Ed-Fi Data v3.5 - Student Special
Education Program Associations (https://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-
special-education-program-associations)

Path: System Administration > Ed-Fi

Arizona Special Ed IEP Fix (SIS-152872)

Previously, several fields on the Enrollments tool were hidden in order to fix a state reporting
issue. This was causing further issues and has been fixed. The following fields now display:

Student Information > Special Ed > General > Documents > Arizona IEP 2020 > Enrollment
Status editor
Secondary Disability
Tertiary Disability
Disability 4
Disability 5
Disability 6

Student Information > Special Ed > General > Documents > Arizona ESR14 Exit Evaluation >
Evaluation Information editor

Exit Reason

Article: Individual Education Plan (Arizona) (https://infinite-campus-oct-22.knowledgeowl.com/help/individual-
education-plan-arizona)

Path: Student Information > Special Ed > General > Documents

Arizona – Luganda Language Added (SIS-153077)

Language code ‘900 – Luganda – lug’ has been added.

Article(s): N/A

Path: N/A

BIE
BIE– New ERC Field (School History) and BIE Version Added to Enrollment Summary Report (SIS-
129490)

BIE Regions organization groups have changed from historic ELOs to new ERCs. To facilitate this
change within Infinite Campus, a new Education Resource Center (ERC) field has been added to
School History in System Administration > Resources > School. A script has been run to pre-
populate ERC values for BIE schools

https://infinite-campus-oct-22.knowledgeowl.com/help/arizona-ed-fi-data-v35-student-needs
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An enhancement has also been made to the Enrollment Summary report (Student Information)
providing BIE districts the option to choose which version to generate the report in: BIE or Core.
When BIE is the selected version, additional BIE specific fields display in the report editor. In
addition, CSV has been added to the available Report Formats for the BIE version only. The Core
version will continue to only offer PDF, HTML, and DOCX report formats

Article(s): Controlled Reports and PII (https://infinite-campus-oct-22.knowledgeowl.com/help/pii-in-reports-personally-
identifying-information)

Path: Student Information > Reports > Enrollment Summary

BIE – CONTROLLED Header Removed From BIE Reports Not Containing PII (SIS-150477)

Previously, due to privacy concerns within the BIE, a CONTROLLED header was added to BIE
reports to indicate the report may contain PII (Personally Identifying Information). This did not
apply to all reports and the CONTROLLED terminology has been removed from reports that do not
include PII.

Article(s): Controlled Reports and PII (https://infinite-campus-oct-22.knowledgeowl.com/help/pii-in-reports-personally-
identifying-information)

Path: BIE Reports

Update for BIE Reports with PII (SIS-150530)

An enhancement was made to the Fee Billing Batch Report and the Fee Receivable Summary
Report for BIE districts. A new header was added to indicate the report includes PII. PII (Personally
Identifying Information) is private or sensitive information that can be used to personally identify
or personally contact an individual. The new header states "CONTROLLED: This page contains PII
and should be handled to protect privacy."

Article(s): Fee Billing Batch Report; Fee Receivable Summary Report

Path: Fees > Reports > Fee Billing Batch; Fees > Reports > Fee Receivable Summary

BIE – Time-Based Two-Factor Authentication Enabled for All User Accounts (SIS-152925)

Per a requirement from the Bureau of Indian Education, time-based two-factor authentication has
been enabled for all user accounts and cannot be disabled.

For more information about this process, please see the Login Security Settings article.

Article(s): Login Security Settings

Path: System Administration > User Security > User Preference Management > Login Security
Settings
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California
California - CALPADS Student Information Address Logic (SIS-150351)

Field 31, Residential Address Line 1, has been modified to no longer require a number to be
included in the report. This allows addresses that have not yet been verified (between locations,
those marked as General Delivery, etc.) to report.

Article(s): CALPADS Student Information (https://infinite-campus-oct-22.knowledgeowl.com/help/calpads-student-
information-sinf)

Path: CA State Reporting > CALPADS Student Information

California - Monthly Attendance Summary (SIS-151135)

The Monthly Attendance Summary has been modified to include options in the Report Period for a
new Date Range Option. Also, the 19-20 Options now include a warning that those can only be
selected when generating the report for 19-20 calendars.

In addition, a sum for each grade level for all attendance funding categories combined for each
selected calendar prints on the report, as well as a grand total for all grades for each selected
calendar.

Article(s): Monthly Attendance Summary (https://infinite-campus-oct-22.knowledgeowl.com/help/monthly-attendance-
summary-california)

Path: CA State Reporting > Monthly Attendance Summary

California - CALPADS Student Information Preferred First/Last Name Values (SIS-152101)

When a student has multiple identities, the CALPADS SINF Extract was incorrectly reporting the
student's names.

When Include All Identities is marked on the Report Editor, only one record was included in
the report for the student
The student's Preferred First/Last Name was reporting the same as the student's First/Last
Name.

These issues have been corrected.

Article(s): CALPADS Student Information (https://infinite-campus-oct-22.knowledgeowl.com/help/calpads-student-
information-sinf)

Path: CA State Reporting > CALPADS Student Information

Colorado
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Colorado Evaluation Fix (SIS-151294)

A text wrapping issue on the Colorado Evaluation has been resolved.

Article: Evaluation (Colorado) (https://infinite-campus-oct-22.knowledgeowl.com/help/evaluation-colorado)

Path: Student Information > Special Ed > General > Documents

Colorado - Graduation Guidelines (SIS-152765)

Graduation Guidelines assessment logic has been modified to only report a record when the
assessment is mapped to a Test Subject area AND there is a a value in either the Raw or Scale
score field. Previously, a record reported when the assessment is mapped to a Test Subject and
there was not a value in the Raw or Scale score fields.

Article(s): Student Interchange - Graduation Guidelines (https://infinite-campus-oct-
22.knowledgeowl.com/help/graduation-guidelines-colorado)

Path: CO State Reporting > Data Pipeline > Student Interchange > Graduation Guidelines

Hawaii
Hawaii Special Ed Plan Added (SIS-150607)

A new Special Ed plan, Private School Participation Project 2022, has been added for Hawaii.

Article: Private School Plan (Hawaii) (https://infinite-campus-oct-22.knowledgeowl.com/help/private-school-plan-hawaii)

Path: Student Information > Special Ed > General > Documents

Hawaii Comparable Service Plan Added (SIS-152387)

A new plan type, Comparable Services, has been added for Hawaii.

Article: Comparable Services Plan (Hawaii) (https://infinite-campus-oct-22.knowledgeowl.com/help/comparable-
services-plan-hawaii)

Path: Student Information > Special Ed > General > Documents

Idaho
Idaho - State Programs in Navigation (SIS-152959)

Previously, the state program tools were missing from the new navigation of Campus. This has
been corrected.

Article(s): State Programs (https://infinite-campus-oct-22.knowledgeowl.com/help/state-programs)
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Path: Student Information > Program Participation > State Programs

Illinois
Illinois - Gender Reporting (SIS-151902)

In accordance with Public Act 102-0543, ISBE now requires additional reporting on student
demographic data as of the 2022-23 school year, as follows:

The term 'Gender' is being retired at the end of the 2022 school year.
Instead of Gender, the term 'Sex' will be used. This is defined as "a label a person is given at
birth, based on ... the interpretation of the newborn's physical characteristics."
Options for Sex are Male, Female, and Intersex. Consult ISBE for definitions of these terms.
Note that 'Intersex' replaces 'Non-Binary'.

In Campus, the Gender field on the person's Identity record has been changed to Sex. The Non-
Binary option is now Intersex, and any student who had the Gender field set to the Non-Binary
value now has the Sex field set to the Intersex option.

The ISBE Demographics and Early Childhood Extract and the ISBE Student Demographics and
Enrollment Extract have been modified for these changes.

Article(s): ISBE Demographics and Early Childhood Extract (https://infinite-campus-oct-
22.knowledgeowl.com/help/isbe-demographics-and-early-childhood-extract-illinois); ISBE Student Demographics and
Enrollment (https://infinite-campus-oct-22.knowledgeowl.com/help/isbe-student-demographics-and-enrollment-extract-illinois)

Path: IL State Reporting > ISBE Extracts > Demographics and Early Childhood, Student
Demographics and Enrollment

Illinois - Student Course Assignment Extract - Course End Date (SIS-152496)

The Course End Date field was incorrectly reporting the End Date entered in the Extract options.
This has been corrected to report as follows:

If there is an End Date entered in the Roster Edit field on the student's Schedule tab for a
course, that date reports.
If the Roster Edit field is not populated, the End Date for the last term in which the section is
scheduled reports.
If the course/section ends after the date the report is generated, or the end date on the
student's schedule (roster) is after the date the report is generated, no date reports.

Article(s): K-12 Student Course Assignment Extract V2 (Illinois) (https://infinite-campus-oct-
22.knowledgeowl.com/help/k-12-student-course-assignment-extract-v2-illinois)

Path: IL State Reporting > Student Course Assignment > K-12 Student Course Assignment V2

Illinois - IEIN Value on Birth to 3 Program Editor (SIS-152620)
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The IEIN field has been increased to allow for the entry of a 7-digit number.

Article(s): Birth to 3 Program (Illinois) (https://infinite-campus-oct-22.knowledgeowl.com/help/birth-to-3-program-illinois)

Path: Student Information > Program Participation > Birth to 3 Program

Illinois - ISBE Extracts and Strip Apostrophes (SIS-153176)

A recent update to the Strip Apostrophes option on ISBE Extracts caused an issue where
apostrophes in name fields were not removed when marked. This has been corrected.

In addition, the ISBE Student Demographics and Enrollments Extract was incorrectly reporting the
Percent of Day column as 100, instead of 1.0. This has been corrected.

Article(s): ISBE Extracts (https://infinite-campus-oct-22.knowledgeowl.com/help/isbe-extracts-illinois)

Path: IL State Reporting > ISBE Extracts

Indiana
Indiana - Ed-Fi Staff Section Associations Resource (SIS-151287)

The Staff Section Associations resource has been made available for Ed-Fi reporting.

Article(s): Indiana Ed-Fi Data v2.4/3.1 – Staff Section Associations (https://infinite-campus-oct-
22.knowledgeowl.com/help/indiana-ed-fi-data-v2431-staff-section-associations)

Path: System Administration > Ed-Fi

Indiana - Ed-Fi Student Title 1 Part A Program Associations Resource (SIS-151289)

The Student Title 1 Part A Program Associations resource has been made available for Ed-Fi
reporting.

Article(s): Indiana Ed-Fi Data v2.4/3.1 - Student Title 1 Part A Program Associations (https://infinite-
campus-oct-22.knowledgeowl.com/help/indiana-ed-fi-data-v2431-student-title-1-part-a-program-associations)

Path: System Administration > Ed-Fi

Kentucky
Kentucky – Custom Gifted Form Batch Print Tool Updated to Print Interactive with Database Table
Forms (SIS-151714) [Enhancement] 

The Custom Gifted Form Batch Print tool has been updated to allow printing of Interactive with
Database Table forms.
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Article(s): Custom Gifted Form Batch Print (Kentucky) (https://infinite-campus-oct-
22.knowledgeowl.com/help/custom-gifted-form-batch-print-kentucky)

Path: Student Information > Reports > Custom Gifted Form Batch Print

Kentucky – Birth Country Dictionary Update (SIS-152981)

The Birth Country attribute dictionary has been changed to a locked dictionary that is uniform for
all Kentucky districts. A survey of all KY districts found only a few who had any Birth County codes
that did not match state requirements, all historical birth country data entered has been preserved
and the following conversions were made:

Existing records with a value of CO: Columbia have been converted to 0480: Columbia.
Existing records with a value of MIC: Micronesia (Federated States of) have been converted to
1445: Micronesia (Federated States of).

Article(s): N/A

Path: System Administration > Custom > Attribute/Dictionary > Identity > Birth Country > State
Standard

Kentucky – Validation Added to Pre-School Tab (SIS-153097)

A validation was added to the Pre-School tab, requiring a Preschool Type be selected in order to
save the record.

Also, a validation was added, disabling the Other textbox unless the Other, Specify checkbox is
checked.

Article(s): Pre-School Tab (Kentucky) (https://infinite-campus-oct-22.knowledgeowl.com/help/pre-school-tab-kentucky)

Path: Student Information > General > Pre-School

Maine
Maine – Validation Requiring Date Entered US for an Immigrant Value Removed (SIS-152472)

The validation requiring users enter a Date Entered US value if the Immigrant field is checked has
been removed.

Article(s): Census (Maine) (https://infinite-campus-oct-22.knowledgeowl.com/help/census-maine)

Path: Census > People > Demographics

Maine – Covid Diploma Graduation Year End Status Attribute Added (SIS-152554)
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Graduation (Year End Status) attribute ‘CD: Covid Diploma’ was added.

Article(s): Graduation (Maine) (https://infinite-campus-oct-22.knowledgeowl.com/help/graduation-maine)

Path: Student Information > Graduation > General Graduation Information > Graduation (Year End
Status)

Maryland
Maryland– New National Code Value Added to Test Setup (Assessments) (SIS-152650)

CTE has been added to the National Code drop down list options in Test Setup (Assessments) to
support the use of CTE Assessment in the HSDC state extract.

The new CTE value was also added to the Campus Attribute Dictionary > Test > National Code list
making it available for use in all states.

Article(s): Test Setup (https://infinite-campus-oct-22.knowledgeowl.com/help/test-setup)

Path: Assessments > Test Setup; System Administration > Custom > Attribute Dictionary > Test >
National Code

Maryland– New Values Added to Subject List in Test Setup (Assessments) (SIS-152652)

The following options have been added to the Subject field with a value of “IB Math” in Test Setup
(Assessments) for the Maryland school districts:

1. “IB Math Analysis Appr SL” for Mathematics: Analysis and Approaches SL assessment

2. “IB Math Analysis Appr HL” for Mathematics: Analysis and Approaches HL assessment

3. “IB Math Appl Interpret SL” for Mathematics: Applications and Interpretation SL assessment

All Subjects in the drop down list are now grouped according to the sequence number related to
their value then listed by their reporting code.

Article(s): Test Setup (https://infinite-campus-oct-22.knowledgeowl.com/help/test-setup-category)

Path: Assessments > Test Setup

Maryland– KRA/ELA Extract Updated (SIS-152851)

The Gender element of the KRA/ELA Extract has been updated to report as:

1: Male
2: Female
X: Non-Binary
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Article(s): KRA/ELA Extract (Maryland) (https://infinite-campus-oct-22.knowledgeowl.com/help/kra-ela-extract-maryland)

Path: MD State Reporting > KRA/ELA Extract

Maryland– SCED Course Identifier Code Updates (SIS-152934)

SCED Course Identifier codes have been updated in the Attribute/Dictionary. This includes the
addition of eight new codes. SCED Course Identifier codes are assigned in the NCES Data section of
Course Information.

Article(s): Attribute Dictionary (https://infinite-campus-oct-22.knowledgeowl.com/help/attribute-dictionary)

Path: System Administration > Custom > Attribute/Dictionary > Course > SCED Course Identifier >
State Standard; Course Master > Course Name > NCES Data > NCES Code, SCED Course Identifier

Massachusetts
Massachusetts IEP Fix (SIS-152610)

An issue with the Amendment Editors displaying on the print even while disabled has been fixed.

Article: Individual Education Plan (Massachusetts) (https://infinite-campus-oct-
22.knowledgeowl.com/help/individual-education-plan-massachusetts)

Path: Student Information > Special Ed > General > Documents

Massachusetts – SIF EmploymentRecord Logic Correction (SIS-152811)

Logic for the following EmploymentRecord elements was updated as following:

Active
Report 'true' if any of the following conditions are met:

If employment record end date is null
If employment record end date is equal to or after the state reporting date
If state reported date is 10/1 and the 'Oct 1. Status Override' field equals '01'
If state reported date is in the month of June and the 'EOY Status Override' field
equals '01'

Else, report 'false'
MAEmployementStatus

If state reported date is 10/1 and the 'Oct 1. Status Override' field is populated, report
the Oct. 1 override status value
If state reported date is in the month of June and the 'EOY Status Override' field is
populated, report the EOY override status value
When District Employment End Date = Null or when District Employment End Date =
NOT Null, AND is >= State Reported Date (If state reported date is not populated, use
current date),
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If 'Status' field is populated, report status value
If Status is Null, report 01.

When District Employment End Date = NOT Null, AND is < State Reported Date (If state
reported date is not populated, use current date), report 04.

Article(s): SIF (Massachusetts) (https://infinite-campus-oct-22.knowledgeowl.com/help/sif-massachusetts)

Path: N/A

Massachusetts – Various SIF Updates (SIS-152812)

The following SIF updates were made:

StudentSectionEnrollment
Population requirements were updated to send the object for enrollments with a service
type of 'S' (as long as it is not state excluded)
CourseEnrollmentStatus - If Local Enrollment Status is 1921 OR grade level is 'KP', 'KT',
or 'KF' and Roster End Date = NOT Null and Roster End Date = the calendar day in the
enrollment calendar with a Day Event = SD and course term end date is < = the state
reporting date, report 03

StudentSectionMarks
Population requirements were updated to send the object for enrollments with a service
type of 'S' (as long as it is not state excluded).
MarkList/Mark/Percentage and MarkList/Mark/Letter

When Enrollment end date is not null AND Enrollment End Status is 1921, 1928,
3501 or Null AND the roster Enrollment Status is null or '03' AND the state score
local code is not 21, 22 or 23 or 40 or 50:
When Enrollment end date is not null AND Enrollment End Status is 1921, 1928,
3501 or Null:

StaffSectionAssignment
Population requirements were updated to allow for section assignments to send when all
rostered students have secondary enrollments, as long as at least one student has a
non-state excluded secondary enrollment.

SectionInfo
Population requirements were updated to allow for sections to send when all rostered
students have secondary enrollments, as long as at least one student has a non-state
excluded secondary enrollment

SectionMarkInfo
Population requirements were updated to allow for sections to send when all rostered
students have secondary enrollments, as long as at least one student has a non-state
excluded secondary enrollment

Article(s): SIF (Massachusetts) (https://infinite-campus-oct-22.knowledgeowl.com/help/sif-massachusetts)

Path: N/A
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Massachusetts – SIF StaffAssignment Updated to Report Sections with Non-State Excluded
Secondary Enrollments (SIS-153138)

Reporting logic for the SIF StaffAssignment object has been updated to include non-state excluded
secondary enrollments. If all assigned sections have no students with primary enrollments or non-
excluded secondary enrollments rostered into the reporting course, the StaffAssignment will not
pull.

Article(s): SIF (Massachusetts) (https://infinite-campus-oct-22.knowledgeowl.com/help/sif-massachusetts)

Path: N/A

Massachusetts – Behavior State Event and Weapon Type Updates (SIS-153212)

The following Behavior State Event Codes were deactivated:

MA51: Explosive or Incendiary Device
0011: Handgun
0012: Shotgun/rifle
0013: Other type of firearm
0021: Knife with blade less than 2.5 inches
0023: Knife with blade greater than or equal to 2.5 inches
0029: Other knife
0030: Other Sharp Objects
0040: Other Object
0050: Substance used as Weapon
0099: Unknown Weapon

Weapon Type code 0098: No Weapon has been added and code MA14: Rifle has been deactivated.

Article(s): Behavior Management Tool (https://infinite-campus-oct-22.knowledgeowl.com/help/behavior-management-
tool)

Path: Behavior > Behavior Management

Michigan
Michigan - State Graduation Seals (SIS-152343)

The Graduation Seals section has been added to the Graduation tab for Michigan. A new field has
been added to the General Collection extract in the Enrollment component called
AdditionalGraduationAward, which reports State Seal information.

Article(s): Graduation (https://infinite-campus-oct-22.knowledgeowl.com/help/graduation-michigan), General Collection
(https://infinite-campus-oct-22.knowledgeowl.com/help/general-collection-michigan)

Path: Student Information > General > Graduation; MI State Reporting > MSDS Extracts > General
Collection
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Michigan - Ed-Fi Student School Associations Update (SIS-152546)

An unknown transformation error occurring on the Student School Associations resource has been
corrected.

Article(s): Michigan Ed-Fi Data v3.1 – Student School Associations (https://infinite-campus-oct-
22.knowledgeowl.com/help/michigan-ed-fi-data-v31-student-school-association)

Path: System Administration > Ed-Fi

Minnesota
Minnesota - MCCC Staff Course Record Update (SIS-143241)

The FileFolderNumber field of the Staff Course Record has been updated so that, when multiple
license records are found, the License Number reports from the most recent record that has a
License Number entered.

Article(s): Staff Course Record (https://infinite-campus-oct-22.knowledgeowl.com/help/mccc-staff-course-record-
minnesota)

Path: MN State Reporting > MCCC Extracts > Staff Course Record

Minnesota IEP Print Fix (SIS-151556)

A print issue with the MN 281 IEP, MN ISP 123, and the Campus Default IEP has been resolved.

Article: Individual Education Plan (Minnesota) (https://infinite-campus-oct-22.knowledgeowl.com/help/individual-
education-plan-minnesota); Campus Default IEP (https://infinite-campus-oct-22.knowledgeowl.com/help/campus-default-iep)

Path: Student Information > Special Ed > General > Documents

Minnesota - Ed-Fi Student Education Organization Associations Update (SIS-152712)

The Student Education Organization Associations record was previously being deleted when an
enrollment was ended. The resource has been updated to only delete the Student Education
Organization Associations record when an enrollment is marked as No Show or State Excluded.

Article(s): Minnesota Ed-Fi Data v3.1 - Student Education Organization Associations (https://infinite-
campus-oct-22.knowledgeowl.com/help/minnesota-ed-fi-data-v31---student-education-organization-association)

Path: System Administration > Ed-Fi

Missouri
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Missouri MOSIS Student Core Update (SIS-151618)

The report logic for the following fields have been updated on the MOSIS Student Core extract:

Title III
Immigrant
Tittle III Immigrant
Lunch Status

Article: MOSIS Student Core Extract (Missouri) (https://infinite-campus-oct-22.knowledgeowl.com/help/mosis-student-
core-extract-missouri)

Path: MO State Reporting > MOSIS Extracts > Student Core

Missouri IEP Updates (SIS-152044)

Several updates have been made to the Missouri IEP, including:

a new print format, MO IEP 2022, is now available.
the print format Team Meeting area has been updated to match the State document format.
verbiage on the PLAAFP, Special Considerations, and Regular Education Participation editors
and print areas have been updated.
the Supports for School Personnel editor has been renamed to Parent and School Personnel
Supports.
verbiage on the the Program Mod. and Accommodation editor has been updated.
several checkboxes on the State Assessment Participation editor have been removed.
the Alternate Assessment (MAP-A) editor has been removed.
verbiage on the printed area of the District Wide Alt. Assess has been updated.
several editors, Sections A-B, Section B- Services, Section B - Accommodations/Modifications,
have been renamed to Form G, Form G: Services, and Form G: Accomm. and Mod.
the Form G: Parent Contact Log and Form G: Log of Date(s) of Closure editors have been
removed.

Article: Individual Education Plan (Missouri) (https://infinite-campus-oct-22.knowledgeowl.com/help/individual-
education-plan-missouri)

Path: Student Information > Special Ed > General > Documents

Montana
Montana – Student Locator Age Validation Calculation Update (SIS-152871)

The Student Locator validation age calculation for the ‘Age 19 or 20 Eligible for ANB’ field has been
updated to correctly calculate a student’s age when adding a new student enrollment.

Article(s): Student Locator (https://infinite-campus-oct-22.knowledgeowl.com/help/student-locator)

Path: Student Information > Student Locator
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Nebraska
Nebraska - P-EBT Extract (SIS-149032) [Enhancement] 

A new P-EBT Extract is available for reporting pandemic electronic benefits for students who are
eligible for SNAP or FRPL and meet the criteria to receive P-EBT.

Article(s): P-EBT Extract (Nebraska) (https://infinite-campus-oct-22.knowledgeowl.com/help/p-ebt-extract-nebraska)

Path: NE State Reporting > P-EBT Extract

Nebraska - Home Primary Language Update (SIS-152691)

Language Code 3720 now reads Pashto.

Article(s): Demographics (https://infinite-campus-oct-22.knowledgeowl.com/help/demographics)

Path: Census > People > Demographic

Nevada
Nevada– NV Nutrition Report- NSLP Reporting Logic Updated (SIS-151866)

The NSLP column of the Nevada Nutrition report will report as ‘Y’ if the National School Lunch
Program (NSLP) check box is selected in System Admin > Resources > School > USDA Programs.
Previously, this field required both NSLP check boxes in USDA Programs to be selected.

Article(s): Nutrition Report (Nevada) (https://infinite-campus-oct-22.knowledgeowl.com/help/nutrition-report-nevada)

Path: NV State Reporting > Nutrition Report

Nevada– New Behavior Event Code Mapping Option Added (SIS-152050)

A new option ‘Discrimination Based on Race’ has been added to Behavior State Event Code
Mapping in the Attribute Dictionary.

Article(s): N/A (https://infinite-campus-oct-22.knowledgeowl.com/help/attribute-dictionary-custom)

Path: System Administration > Custom > Attribute/Dictionary > Behavior > State Event Code
Mapping > Dictionary

Nevada– SCED Course Level in Attribute/Dictionary Updated (SIS-152246)

Previously, the SCED Course Level element in Attribute/Dictionary was unlocked and editable. This
has been changed to a locked status to prevent modifications without Nevada DOE approval.
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In addition, code “C: College” has been modified to “C: College or college credit” in the SCED
Course Level dictionary options.

Article(s): Attribute Dictionary (Custom) (https://infinite-campus-oct-22.knowledgeowl.com/help/attribute-dictionary-
custom)

Path: System Administration > Custom > Attribute Dictionary > Course > SCED Course Level >
Dictionary

New Mexico
New Mexico– Student Summary Attendance Template Update(SIS-152881)

Logic has been updated to the ‘Number of Scheduled Periods Attended’ field to include
Absent/Exempt in the count as present.

Article(s): Student Summary Attendance Template (New Mexico) (https://infinite-campus-oct-
22.knowledgeowl.com/help/student-summary-attendance-template-new-mexico)

Path: NM State Reporting > STUD_ATT_SUM

New York
New York SSEC Extract Update (SIS-148983)

Several updates have been made to the layout of the New York SSEC Extract, including:

column 8 has been renamed to Threat of School Violence (Other than Bomb Threat or False
Alarm) and reports behavior events with State Event Code 21.
column 2a and 2b has been consolidated into one column, Sexual Offenses, and reports
behavior events with State Event Code 2.1 and 2.2.
column 3a and 3b has been consolidated into one column, Assault, and reports behavior
events with State Event Code 7 and 4.
column 4a and 4b has been consolidated into one column, Weapons Possession, and reports
behavior events with State Event Code 17.1 and 17.2.

Article: SSEC Extract (New York) (https://infinite-campus-oct-22.knowledgeowl.com/help/ssec-extract-new-york)

Path: NY State Reporting > SSEC Extracts > SSEC

New York SIRS Student Digital Access Fix (SIS-152645)

An issue when generating the SIRS Student Digital Access and selecting only grade KF has been
resolved.

Article: SIRS Student Digital Access (New York) (https://infinite-campus-oct-22.knowledgeowl.com/help/sirs-student-
digital-access-new-york)

Path: NY State Reporting > SIRS Extracts > Student Digital Access
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New York State Program Codes Added (SIS-152695)

The following State Program Codes have been added for New York: 4005 MBK Challenge, 4006
MBK Family and Community Engagement (FCEP), 4007 MBK Exemplary School Models and
Practices (ESMP), 4008 MBK Native American (NAP), and 4009 MBK Fellows (FP).

Article: N/A

Path: Student Information > Program Participation > Programs > Programs > State Program
Code/Student Information > General > Flags > State Program Code

New York SIRS Student Lite Update (SIS-152727)

When a student does not have a physical address reported in ADDRESS 1, NA reports for the CITY,
STATE, and ZIP fields on the SIRS Student Lite extract.

Article: SIRS Student Lite (New York) (https://infinite-campus-oct-22.knowledgeowl.com/help/sirs-student-lite-new-york)

Path: NY State Reporting > SIRS Extracts > Student Lite

New York SIRS Student Daily Attendance Update (SIS-152764)

The New York SIRS Student Daily Attendance extract logic has been updated to not report dates
without scheduled attendance courses.

Article: SIRS Student Daily Attendance (New York) (https://infinite-campus-oct-22.knowledgeowl.com/help/sirs-
student-daily-attendance-new-york)

Path: NY State Reporting > SIRS Extracts > Student Daily Attendance

Ohio
Ohio - Local Student Number (SIS-148718)

Previously, if a student had a Local Student Number before any enrollments were created for the
student, the number would be removed when an enrollment was created. This has been corrected.

Article(s): Demographics (https://infinite-campus-oct-22.knowledgeowl.com/help/demographics-d597d2f)

Path: Census > People > Demographics > Local Student Number

Ohio - Student Assessment (FA) Extract Update (SIS-150272)
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Field logic for the Score field in for GX assessment type has been updated to report Scale Score if
greater than 0. If Scale Score is 0 or null, reports the Result if not null. Otherwise reports as ***.

Article(s): FA (https://infinite-campus-oct-22.knowledgeowl.com/help/student-assessment-fa-ohio-extracts)

Path: OH State Reporting > OH Extracts > FA

Ohio - CORE Area for Credit Field (SIS-150451)

The CORE Area for Credit code list has been updated per state guidance, including converting
code SEA to SAE and code MTC to MCT.

Article(s): N/A

Path: Scheduling > Courses > Course; Student Information > General > Transcripts

Ohio Immunizations Update (SIS-151841)

The Influenza (Flu) vaccine compliance rules have been updated for Ohio.

Article: Immunization Rules (Ohio) (https://infinite-campus-oct-22.knowledgeowl.com/help/immunization-rules-ohio)

Path: System Administration > Health > Vaccines

Ohio - Student Standing (FS) Performance (SIS-152982)

Updates have been made to improve the performance of the FS extract.

Article(s): FS (https://infinite-campus-oct-22.knowledgeowl.com/help/student-standing-fs-ohio-extracts)

Path: OH State Reporting > OH Extracts > FS

Oklahoma
Oklahoma - Course State Exclude Checkbox (SIS-152320)

A State Exclude checkbox has been added to the Course tab for Oklahoma. SIF objects
SchoolCourseInfo, StudentSectionEnrollment, SectionInfo, and StudentSectionMarks have been
updated to account for this option.

Article(s): Courses (https://infinite-campus-oct-22.knowledgeowl.com/help/course-information1)

Path: Scheduling > Courses > Course
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Oklahoma - Statistical Summary Report, Transportation Report (SIS-152694) [Enhancement] 

A new Report Order Format option has been added to the Statistical Summary Report editor, which
allows the report to be generated in one of two ways - Campus Default or State Order. The State
Order displays membership and attendance information first, and allows districts to more easily
reconcile the information.

A Legally Transported column has been added to the Transportation State Report. This column
calculated the same as the Legally Transported column on the Statistical Summary Report.

Article(s): Statistical Summary (Oklahoma) (https://infinite-campus-oct-22.knowledgeowl.com/help/statistical-
summary-report-oklahoma); Transportation Report (Oklahoma) (https://infinite-campus-oct-
22.knowledgeowl.com/help/transportation-report-oklahoma)

Path: OK State Reporting > Statistical Summary, Transportation Report

Oklahoma - Native American Eligibility and Custom Attributes (SIS-152705)

Districts can now add Custom attributes to the Native American Eligibility tool.

Article(s): Attribute Dictionary (Custom) (https://infinite-campus-oct-22.knowledgeowl.com/help/attribute-dictionary-
custom)

Path: System Administration > Custom > Attribute/Dictionary; Student Information > General >
Native American Eligibility

Oklahoma - Attendance Summary (SIS-152722) [Enhancement] 

An Unreported Terms Report Blank field has been added to the Attendance Summary Report.
When marked, the terms that report as 0.0 will instead report blank.

Article(s): Attendance Summary Report (Oklahoma) (https://infinite-campus-oct-
22.knowledgeowl.com/help/attendance-summary-report-oklahoma)

Path: OK State Reporting > Attendance Summary Report

Pennsylvania
Pennsylvania Immunizations Update (SIS-139833)

The Polio vaccine compliance rules have been updated for Pennsylvania.

Article: Immunization Rules (Pennsylvania) (https://infinite-campus-oct-22.knowledgeowl.com/help/immunization-
rules-pennsylvania)

Path: System Administration > Health > Vaccines
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Pennsylvania PIMS Programs Fact Template Logic Update (SIS-152593)

Logic for reporting on the PIMS Programs Fact Template has been updated to the following:

Programs entered on the Graduation and Academic/CTE Programs tools no longer report.
Programs from the Programs or Flags tool (029, 030, 035-038), Homeless tool (055, 056), and
PA Instruction Mode tool (060, 061) report. Programs and/or Flags must have a Code
populated, marked as Active and State Reported in order to report.

Article: PIMS Programs Fact Template (Pennsylvania) (https://infinite-campus-oct-22.knowledgeowl.com/help/pims-
programs-fact-template-pennsylvania)

Path: PA State Reporting > PIMS Extracts > Programs Fact Template

Tennessee
Tennessee Immunizations Update (SIS-137563)

The Pneumococcal (PPV) vaccine compliance rules have been updated for Tennessee.

Article: Immunization Rules (Tennessee) (https://infinite-campus-oct-22.knowledgeowl.com/help/immunization-rules-
tennessee)

Path: System Administration > Health > Vaccines

Tennessee - 22-23 Version (SIS-151745)

A new 22-23 version has been added for EIS extracts. The 20-21 version has been removed from
the editor.

Article(s):EIS Batch Transmission (https://infinite-campus-oct-22.knowledgeowl.com/help/eis-batch-transmission-
tennessee)

Path: TN State Reporting > EIS Batch Transmission

Texas
Texas– Logic Updated to Student Parent Interchange for ECDS KG Submission (SIS-152800)

Logic has been updated to Middle Name and Limited English Proficiency reporting elements for the
ECDS submission in the Student Parent Interchange TSDS Extract.

Middle Name element update includes:

If student’s middle name is blank, the element does not report. This applies to ECDS (KG)
only.

Limited English Proficiency element update includes:
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Non-Emergent Bilingual reports if the student does not have an active EL record at the time of
reporting OR is not in monitoring status.
Emergent Bilingual reports if the student has an active EL record at the time of reporting.
Emergent Bilingual Monitored 1 reports if the student has an end dated EL record and is in
monitoring status.
Emergent Bilingual Monitored 2 reports if the student has an end dated EL record and is in
monitoring status.

Article(s): Student Parent Interchange (TSDS) (Texas) (https://infinite-campus-oct-
22.knowledgeowl.com/help/student-parent-tsds-texas)

Path: TX State Reporting > TSDS Extracts

Texas–Assessment Logic Updated in the TREx Extract (SIS-153060)

Following the Campus.2203 release, multiple state test codes were not following the update made
to the Assessment logic in the TREx Extract. This has been fixed.

Article(s): TREx Extract (https://infinite-campus-oct-22.knowledgeowl.com/help/trex-extract-texas)

Path: TX State Reporting > TREx Extract

Wisconsin
Wisconsin Special Ed Updates (SIS-151707)

Several updates have been made to the Wisconsin Special Education area. Updates to the
Eligibility include:

verbiage on the ER-1 Eligibility Determination editor has been updated.
Updates to the IEP and ISP include:
a sequence field has been added to the Supplementary Services, Special Education Services,
Related Services, and Program Modifications Services editors.

Article: Individual Education Plan (Wisconsin) (https://infinite-campus-oct-22.knowledgeowl.com/help/individual-
education-plan-wisconsin)

Path: Student Information > Special Ed > General > Documents

Wisconsin - WISE Attendance Audit Update (SIS-151907)

The Effective Date field in the WISE Attendance Audit has been removed and the Start Date and
End Date fields have been added.

The reporting logic for the Actual Days Attendance and Possible Days Attendance have been
updated to report using the new Start and End Date fields.
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Article(s): WISE Attendance Audit (https://infinite-campus-oct-22.knowledgeowl.com/help/wise-attendance-audit)

Path: WI State Reporting > WISE Attendance Audit

Wisconsin - Ed-Fi Student CTE Program Association Error (SIS-152473)

An unknown transformation error occurring on the Student CTE Program Association resource has
been corrected.

Article(s): Wisconsin Ed-Fi Data v3.3 - Student CTE Program Associations (https://infinite-campus-oct-
22.knowledgeowl.com/help/wisconsin-ed-fi-data-v33-student-cte-program-associations)

Path: System Administration > Ed-Fi

Wyoming
Wyoming – SIF Attendance Calculation Field Added to Calendar and Related SIF Updates (SIS-
149582)

A new SIF Attendance Calculation field has been added to the Calendar tab. This field allows
districts to report each calendar using their preferred attendance calculation method (i.e., Minutes
Per Day, Minutes Per Enrollment, etc).

The following StudentAttendanceSummary elements have been updated to properly report data
based on the SIF Attendance Calculation value selected on the reporting calendar:

DaysAttended
ExcusedAbsences
Unexcused Absences
DaysInMembership

Logic for the StudentAttendanceSummary/DaysAttendedRemote extended element has been
updated to include the following:

Non-Blended learning group - one-off day:
Count the attendance for the student's enrolled instructional days when the student has
an attendance code assigned to ALL instructional periods of their day where the
Attendance Code has a State Code = RL, AND:

When student calculates as full day absent, do not add additional attendance (0.0).
When student calculates as half day absent, add 0.5.
When student calculates as full day present, add 1.0.

When the calendar has SIF Attendance Calculation = Minutes, Per Day:
Use the WDE600 "Minutes, Per Day" attendance calculation.

When the calendar has SIF Attendance Calculation = Minutes, Per Enrollment:
Use the WDE600 "Minutes, Per Enrollment" attendance calculation.

When the calendar has SIF Attendance Calculation = Periods, Per Day:
Use the WDE600 "Periods, Per Day" attendance calculation.

When the calendar has SIF Attendance Calculation = Periods, Per Enrollment:
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Use the WDE600 "Periods, Per Enrollment" attendance calculation.

Logic for the StudentAttendanceSummary/DaysAbsentRemote extended element has been
updated to include the following:

When the calendar has SIF Attendance Calculation = Minutes, Per Day:
Use the WDE600 "Minutes, Per Day" attendance calculation.

When the calendar has SIF Attendance Calculation = Minutes, Per Enrollment:
Use the WDE600 "Minutes, Per Enrollment" attendance calculation.

When the calendar has SIF Attendance Calculation = Periods, Per Day:
Use the WDE600 "Periods, Per Day" attendance calculation.

When the calendar has SIF Attendance Calculation = Periods, Per Enrollment:
Use the WDE600 "Periods, Per Enrollment" attendance calculation.

Also, performance issues tied to blended learning data in the StudentAttendanceSummary object
was corrected.

Article(s): SIF (Wyoming) (https://infinite-campus-oct-22.knowledgeowl.com/help/sif-wyoming)

Path: N/A

Wyoming IEP Update (SIS-151622)

The Locations field on the Supplementary and Modifications Services editor has been updated to
remain visible when the Sessions not applicable checkbox is marked.

Article: Individual Education Plan (Wyoming) (https://infinite-campus-oct-22.knowledgeowl.com/help/individual-
education-plan-wyoming)

Path: Student Information > Special Ed > General > Document

Wyoming - WDE-638 Course File (SIS-152311)

The State_Course_ID field in the WDE-638 extract has been renamed to StateCourseID.
Additionally, the InstructionLevel field has been removed.

Article(s): WDE-638 (https://infinite-campus-oct-22.knowledgeowl.com/help/wde-638-extract-wyoming)

Path: WY State Reporting > WDE-638

Wyoming – SIF StudentParticipation Logic Update (SIS-152334)

Population logic for the StudentParticipation object has been updated to the following:

Reports up to 1 StudentParticipation record per primary enrollment:
For the most recent (latest Start Date) locked IEP (with any Print Format) in the Zone
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calendar year that overlaps the primary enrollment's Start and End Date range, report
an instance of StudentParticipation when the IEP Start Date <= current Date

When Student has a locked, "Initial" Evaluation at any time during the SIF Zone Year, and
does NOT have a locked IEP during the Zone Year, report a StudentParticipation instance.

(Student Info>Special Ed>Documents>Evaluation)
When a SIF element in the object pulls from enrollment, it must pull from the most recent
(latest Start Date) Primary enrollment tied to the IEP in the Zone Year.

When no Primary enrollment overlaps the IEP daterange in the Zone Year, then does not
report a StudentParticipation object for this IEP.
We can recognize that an IEP is associated with the enrollment when the IEP pushes
some of the field values down to the Special Ed Fields section on the enrollment.

Logic for the StudentParticipationAsOfDate element has been updated to the following:

When the StudentParticipation record is reporting from the IEP:
Report the reported IEP's Modified Date (Student Info > Special Ed > General >
Documents > IEP > Education Plan > Modified Date)

When the StudentParticipation record is reporting from the Evaluation:
Report the reported Evaluation's Modified Date (Student Info > Special Ed > General >
Documents > Eval > Evaluation Editor > Modified Date)

Article(s): SIF (Wyoming) (https://infinite-campus-oct-22.knowledgeowl.com/help/sif-wyoming)

Path: N/A
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